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Alzex Personal Finance software
Alzex Personal Finance is an intuitive and easy-to-use home budget software. As distinct from other
applications, Alzex Personal Finance software offers a nice-looking and well thought-out interface, ease of use
and clear presentation of results. The program can help you control your budget, understand where your money
goes, pinpoint the areas of excessive expenditure and cut down unnecessary expenses.
 
The program requires little time for keeping track of personal budget. It is easy to learn for beginners and
provides a rich set of features for power users.
 
You can install the program on a USB drive and have it always at hand. You can track home budget on any
computer at home, in the office, or on the move (even if software installation is forbidden by the administrator). All
data is stored on a USB drive and no traces are left on a computer.
 
The idea behind the program is to divide expenses (and income) by categories. It allows you to see where and
how much money is spent without analyzing reports. Categories are presented as a tree with unlimited nesting.
Each category may have subcategories that may have their own subcategories. Also expenses (income) may be
divided by family members and defined with tags. So you can easily see the flow of money from the big picture
down to the smallest details.
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Getting started
When you run Alzex Personal Finance software for the first time, it prompts you to open a demo database. This
database is partially completed with data and contains several accounts, a tree of categories and expenses for
one month. Beginners are recommended to use this database to learn software and basics of budgeting: you can
add several transactions and play with the settings to familiarize yourself with the interface and features of the
program. After viewing the demo database, go on to create your own database.
 

 
Alzex Personal Finance software lets you work with unlimited number of databases. A database is a file with a
PFD extension. Since all information is stored in one small file, you can easily move it to a new location, copy
to disk, send by email, or make a backup copy (File > Save as...). You can save a database file to a network
shared drive and work with it from different computers simultaneously. A budget database can be protected with
a password.
 
It is recommended to back up the database regularly and save backup copies to a safe location (CD/DVD, USB
drive). It can help you to restore data quickly in case of computer crashes or disk failures. To create a backup
copy of the database, click File > Save as... or enable automatic backup in the application settings.
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Creating a new database
When creating a new database you can copy part or all of the structure of the current database. We recommend
that you at least use the currencies and basic categories from the demo database.
 

 
Open the demo database if you have not already done so. In the File menu, select "New". Select "Copy
structure" and check the boxes next to the items you wish to copy from the current database. Enter the file name
(for example, "My Finances") and click "Save". Your database has been created. Now you need to select your
currencies.
 

Helpful hints

• After creating a new database, be sure to go to the currencies list and select the default currency, if it has
not yet been selected.

• If an account is copied, the opening account balance in the new database will equal the current balance on
the account in the original database. This is convenient if, for example, each year you open a new database
and archive the old one.
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Currency selection
The first thing to do is to choose which currencies you want to work with. To open the currency list, go to the
Tools menu and click "Currencies". The list contains all the world's currencies, as well as precious metals. You
can also add your own currencies, including "virtual currencies". Selected currencies are listed first, unselected
currencies are grayed out, and the default currency is marked with a star. If you selected the currencies from the
demo database, dollars and euros will already be listed. To find and add a currency, enter its alphabetic code or
part of the name in the search field below. For example, entering "GBP" will leave a single currency in the list: the
British pound.

 

 
Double-click a currency to view its properties. For convenience it is best to rename it to "Pounds" and change
the designation from "GBP" to the £ symbol (you can copy the symbol straight from here). The currency code is
used to load exchange rates from the internet. Codes for built-in currencies cannot be changed. Uncheck "Hide
currency" to make it available for use. Click "OK". That's it – your currency is ready to use.
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Be sure to set the default currency by selecting it from the list and clicking "Set default". A total balance for all
accounts is displayed in the default currency, and amounts will be calculated using it in many other places as
well. You can hide unused currencies by selecting them from the list and clicking "Disable". After selecting your
currencies, proceed to account creation.
 

Helpful hints

• In the "Symbol" field you can add a space to separate the amount from the currency symbol.
• You can also select the symbol alignment: to the left of the amount ($100) or to the right (100$).
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Account creation
The second step is account creation. In the Tools menu, click "Accounts". A list of accounts will appear. An
account in this program reflects an actual bank account or other places where money is kept: wallet, credit card,
PayPal, etc.
 

 
To create a new account, click "Add", then select "Account". In the window that opens, enter the name of the
account (for example, "Cash"), select the symbol and account currency, and enter the opening balance – that is,
the current remaining balance on the account (or amount in your wallet). Click "OK" to create the account.
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Add the rest of your accounts to the program the same way. After all the required accounts have been created,
go on to create categories.
 

Helpful hints

• Accounts may be grouped by categories, which is very convenient if you have a large number of accounts.
• Accounts that are rarely used may be hidden. Hiding accounts avoids clutter, and if needed they can quickly

be restored (click "Accounts" on the toolbar and check the box next to "Hidden accounts").
• The opening balance can also be entered as an income transaction, which in some cases is more

convenient.
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Creating categories
Home accounting is based on the idea of sorting income and expenses into categories. This makes it easy to
see how much money is being spent on what, and to analyze and reduce unnecessary spending. The category
system takes the form of an unlimited tree chart: each category can have subcategories, which in turn can have
subcategories of their own, and so on. In general, expense classification in this program is highly developed: you
can sort transactions by family member, payee, and project, assign unlimited tags, "star" important transactions,
and set transaction status. This makes it easy to track the movements of all your funds – from an overview down
to the minutest details.
 
In the Tools menu, select "Categories". A list of categories will appear. If you have used the categories from the
demo database, there will already be several typical categories listed. You can drag and drop categories from
one to another and rearrange them using the buttons on the toolbar to the right.
 

 
To create a category, click "Add". Enter the category name and select an icon.
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An approximate category tree can be created immediately, or categories can be added as needed at the time of
data entry. There is no need to concentrate too heavily on this; experience has shown that you will completely
rearrange the category tree several times as you use the program. The program has all the tools necessary to
quickly and easily transfer transactions from one category to another, and to re-sort and reclassify expenses
(batch editing and filters, undoing and redoing any changes). Create several categories, or proceed immediately
to expense accounting.
 

Helpful hints

• You can specify a type of category (income or expense) by clicking the button beside its name. Income
categories do not appear in the list when creating an expense transaction, and vice versa.

• When you delete a category, all transactions from that category revert to the parent category. To quickly
transfer all transactions from one category to another, drag the first category into the second with the mouse
(making the second category the parent of the first) and delete the child category.

• To transfer a category to the root, drag it to an empty spot, or click "Move to root" in the context menu.
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Financial accounting
Now that we have completed our preparations we are ready to begin the accounting process itself, by entering
data into the program. There are at least two basic ways to manage personal finances: by entering overall
expenses, using only a few basic categories, and by entering them in detail, noting every little purchase
individually. We recommend that you begin with the first of these, by creating several basic top-level categories:
Groceries, Clothing, Rent (and other obligatory regular payments), Entertainment, and Miscellaneous. This
will save considerable time, and later, if you feel the need for more detail, you can break down the categories
into subcategories and switch to more detailed accounting. Previously entered transactions can also easily be
reorganized using batch editing. 
 
Go to the transaction list. In the View menu select "Transactions" or click the button of the same name on the
toolbar.
 

 
To create a new transaction, click "Add" and select "Transaction" from the list. Enter the transaction description,
date, and amount – the minimum required for entering an expense into the program. Click the "Advanced
settings" button, and select the transaction category from the menu that appears.
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We recommend that you choose a logical and unique name for the transaction. For example, “Groceries”,
“Clothing”, or “Alcoholic beverages”, if you are tracking overall expenses. Or “Bread”, “Shoes”, or “Wine”, if you
are keeping detailed accounts. This will allow you to swiftly enter these expenses in the future by entering the first
few letters of the name and selecting the transaction from the list. The category, amount, and other parameters
will be filled out automatically. Just adjust the necessary fields and you're done.
 
Income is entered into the program the same way: you can select the transaction type from the top toolbar. When
transferring funds from one account to another, if the accounts use different currencies you will need to specify
the exchange rate. The program provides the current rate automatically, but it will most likely need to be adjusted
to reflect the rate at which the currency was actually purchased or sold.
 

Financial accounting is only the beginning
You have now mastered financial accounting in the program, and as soon as you have collected enough data
you can get to the fun part. Home accounting is not limited to merely tracking expenses. Tracking your finances
without subsequent analysis is useless. Planning your family budget is where you really want to spend your time.
And that is why you need home accounting software. We also recommend that you read this article: How to use
home budget software.
 

Helpful hints

• Click the "+" button next to the "Amount" field to display additional fields for price and quantity. You can fill
out any two; the third will be calculated automatically.
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• You can quickly enter repeat expenses by copying existing transactions. Select the transaction and
click "Copy" on the toolbar to the right or in the context menu. In the window that appears enter the
necessary changes and click "OK". You can copy categories the same way. In this case the categories in the
transaction creation dialogue will already be completed.

• You can easily transfer one or more transactions from one category to another by simply dragging them with
the mouse. For more complex operations with a transaction group, use batch editing.

• Enter not only current expenses in the program, but also all major upcoming expenses. Suppose, for
example, you know that by next winter you will need new shoes. Enter this into the program and specify the
approximate amount. This is a simple but very effective means of budgeting to avoid being left without funds
when you least expect it.
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Share a budget with your family or colleagues
 

 
Several users can work with a single database file and sync changes over the Internet or local network.
 
Automatic synchronization
Enable automatic synchronization in the app settings (paid subscription required), then send the database file to
your family or colleagues (e.g via email). To make a copy of your database file click main menu - File - Save As.
All changes they're making in their copy will appear on your computer within a few seconds and vice versa.
 

 
You can also download your file from the cloud, if corresponding option is set in the sync settings (main menu -
File - Download from cloud). In another case database file won't be uploaded to cloud and current changes only
will be transferred. If this option is set, there will be changes history in cloud, but no more than one copy per day
for the last week and one copy per week for the last month.
 
If changes aren't appear automatically, click File - Sync now button. In the sync settings also check that file name
and account are the same on all devices and "Automatic sync" option is enabled.
 
Shared file in cloud or network folder
Put your database file in a shared network folder or in a cloud. Install the corresponding cloud client app (Google
Drive, OneDrive, etc) and cloud contents will appear on your PC like ordinary folder. Then work with the file as
usual: double click to open it and all changes made from different devices will be merged in one file and will
appear in the program within a few minutes.
 

• Set up sync with mobile versions: iOS, Android.
• Users and access restrictions

http://www.alzex.com
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Managing data
Add, edit and delete transactions, events, debts, budget and financial goals.

 
Alzex Personal Finance software offers several useful tools to make it easy for you to use the program and save
time.
 
History. This button helps you to enter frequent transactions without having to type data into all fields of the
form manually. Just select a transaction from the list and make a few edits if necessary. Other fields are already
completed with data.
 
Creating copies. You can copy any transaction or category and make edits if necessary.
 
Auto fill. You can either select a transaction name from the list of available names or enter the first letters and
the program fills an appropriate name itself.
 
Saving date of recent transaction. You can easily create several transactions post factum without the need to
enter date of each new transaction.
 
Built-in calculator. To open the calculator, select Tools > Calculator or click the button which you can find in
every field for entering a number or amount. The calculator does basic arithmetic operations and stores one
number in memory. Memory is not cleared after closing the calculator, so stored data can be used later.
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Batch editing
The easiest way to set a category or a family member is to select one ore more transactions and drag them with
the mouse to the necessary category. Batch editing allows you to set a category to a group of records and also
rename them, set status, hide records from other users, protect from editing and much more. Select several
records (you can use filters to select the records), open the panel for batch editing and select the command.
 

Categorize

Organize selected items to categories, family members or add tags.

Check

Check or uncheck selected transactions.

Status

Set the status of a transaction (uncleared, cleared, reconciled).

Rename

Rename selected items.

Access
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Restrict access to selected items (Read / write, visibility, owner). (this function is available in Pro version
only)

Hide
Hide the batch editing panel.
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Interface Overview
Here you can see the overview of accounts, loans, current currency exchange rates, calendar and a list of
transactions or events by days.
 

Calendar settings

Show the current month regardless of the selected time period.

Calendar
Calendar displays transactions and events.

View
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• Show transactions or events.
• Show all days in the list, including blank ones.
• Sort data in ascending or descending order.
• Select columns in the list of transactions /

events.

Group by

Group transactions / events by categories, family members, payee or projects.

Settings panel
See Viewing options.

Filters
Show / hide filter panel.

Actions
Show / hide actions panel.

Uncleared transactions
List of transactions / events waiting for approval.

Currencies
List of available currencies and currency exchange rate.

Overall balance
Overall balance on all accounts, loans and total.

Transactions/events
List of transactions or events grouped by days.
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Main menu

File

• New - create a new database.
• Open - open a database file.
• Save - save changes to the database file. The program saves changes automatically every 15

minutes and when you exit the program.
• Save as... - create a copy of the current database.
• Reopen - open a recently opened database file.
• Set password - set or remove a password for the current user.
• Print - print the current view.
• Exit - close the program.

Edit

• Undo last action
• Redo last action.

View
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• Overview - see brief information about accounts, currency exchange rates, calendar, transactions
and recent events.

• Transactions - view, add, edit and delete transactions.
• Calendar - view transactions and events grouped by days. Account balances and money flow.
• Scheduler - see scheduled transactions and events.
• Events and tasks - view tasks and events.
• Personal budget - monitor savings and home budget.
• Loans - track debts and credits.
• Reports - charts and reports.

Directories

• Currencies.
• Accounts.
• Categories, family members, payee, projects and

tags.
• Users.

Tools
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• Export to QIF, CSV and TXT.
• Import from QIF, OFX, CSV and TXT.
• Reconciliation of accounts with a bank statement.
• Calculator - open the built-in calculator.
• Additional fields - settings of additional transaction fields.
• Application settings (View, language, automatic backups,

etc.)

Help

• Help - user manual.
• Open the online user manual or download a copy of that manual in PDF for

print.
• Visit budget software home page.
• Check for updates.
• Buy the program or enter the registration key.
• About the program.
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Toolbar

Overview
Brief information about accounts, currency exchange rates, calendar, transactions and recent events.
Overview mode.

Transactions
Account operations, add, edit and delete transactions. Managing transactions.

Calendar
Transactions and events are grouped by days. Account balances and cash flow. Using calendar.

Scheduler
List of scheduled transactions and events.

Events and tasks
List of tasks and events. (this function is available in Pro version only)

Home budget
Tracking savings and personal budget.

Loans
Tracking debts and credits.

Reports
Charts and reports.

Currencies
List of currencies and exchange rates.

Accounts
List of accounts.

Categories
List of categories, family members, payee, projects and tags.
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Users
List of users.

Settings
Application settings
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Viewing options
The look and options on the panel depend on the selected mode.
 

Accounts
Show or hide the left panel (accounts or calendar). This panel is not available in some modes.

View
Select columns and other viewing options depending on the current mode.

Group by
Group transactions (events, debts) by categories, family members, payees and projects. Also
transactions can be grouped by checks and description.

Period

The current range of transactions or events. Items that do not fall into this period, are not displayed.

• Back - previous period
• Next - next period
• Central button - select one of the predefined periods (current day, week, month, quarter and year) or

set an arbitrary period.

Filters

Show or hide filter panel. You can use the drop-down menu to select a filter whose state is saved after
restarting the program.

Actions
Show or hide actions panel. Add, Edit or Delete buttons and the panel of batch editing.
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Filters
Alzex Personal Finance software has a powerful and flexible system of filters. The number of available filters
depends on the selected mode. Select the desired value from the drop-down list and click the button to enable
the filter. To select several values, open the list and click "Select categories (accounts, tags)". This opens the
window where you can use the Ctrl or Shift buttons to select several items.
 

Accounts

Filter by accounts. You can select one or more accounts.

Categories, family, payees, projects and tags

Filter by categories, family members, etc.

Status, priority and others

Particular choice of filters depends on the current mode.

Search
Show records containing a specified string.
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Actions

Add
Create a new entry (Transaction, split, event, task, etc.)

Copy
Copy the selected item. If you selected a category or payee, the program creates an entry with
information about the category.

Edit
Edit the selected item

Delete
Delete all selected items

Batch editing
Show the panel of batch editing
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Accounts
The list of accounts is available in the Transactions and Calendar modes. You can see the account name, icon,
current balance in the account currency and comments (if available). When one or more accounts (group) are
selected, you can see transactions associated with that account (accounts). To see all transactions, you need
to select "All accounts". This mode allows you to see the big picture, including the total amount of money in the
main currency and transactions from all accounts. Thus, it is easy to see how much money is spent on petrol,
food from all accounts. Managing accounts.
 

Overall balance
Total balance in the main currency.

Group
Accounts can be organized into groups.

Selected account
Icon, name and balance in the account currency. You can select an account, all accounts, group or
multiple accounts with Ctrl and Shift keys

Balance
Account balance for the current day. History and forecast of the balance by days can be viewed in the
calendar.
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Setting password
You can protect the budget database from unauthorized access with a password. For this, go to the main menu
and select File > Set Password.
 

Password
Enter a password. Leave this field blank if you want to remove the password.

Confirmation
Enter the password again to avoid errors.

Password hint
Enter a hint in case you forget your password.
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Calculator
This budget software has a built-in calculator. To open the calculator, select Tools > Calculator. Also there is a
button for opening the calculator in every field for entering a numerical value or amount. The calculator allows
you to do basic arithmetic operations and save one number in memory. Memory is not cleared after closing the
calculator, which means saved data can be used later in the program.
 

Memory
Managing memory.

• Clear memory.
• Restore a number from memory.
• Save a number to memory.
• Add a number to the current content of

memory.

Reset

• Clear the input
field.

• Complete
reset.

Save result
Close the window and put the result into the input field.
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Print
The program can print a list of transactions, calendar, loans, budget, reports, etc. The list is printed exactly as it is
displayed on the screen. If some branches of the tree are collapsed, their contents is not printed.
 
In some cases (loans and budget), one selected entry can be printed in detail (Selection option in the print
dialog). The program prints information about the loan and list of payments, or information about a budget item
and forecast chart or history of this item.
 

Print
Click this button to open the print dialog.
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Currencies
Alzex Personal Finance software supports an unlimited number of currencies. Currencies represent almost all
countries of the world and precious metals. If necessary, you can add your own currencies, including virtual ones.
Using this section, you can keep track of money and other things (metals, fuel and units of measurement).
 
Enable a currency or currencies. Set the default currency. Once that is done, you will be able to download the
latest currency exchange rates from the Internet.
 

Currencies
List of available currencies. Enabled currencies are on top of the list, disabled currencies are in gray.
Because there are more than 200 different currencies, it is recommended to disable most of them. The
default currency is marked with a star.

Add
Add a new, existing or virtual currency.

Edit
Edit the selected currency.

Delete
Delete the currency from the list. Pre-installed currencies cannot be deleted.

Set default
Set the default currency. This currency is used to show the overall balance and it is also used
everywhere when it is impossible to specify a particular currency.

Disable
Disable (hide) or enable the selected currency.
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Exchange rates
Edit exchange rates.

Update ex. rates
Download currency exchange rate from the Internet.

Search
Show currencies that contain a specified string.
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Currency

Name
Name of currency.

Symbol
Symbol of currency.

Code
Currency code for updating currency rates over the Internet (in ISO 4217). Code of preinstalled
currencies cannot be changed.

Hide
Disable currency.

Default
Set default currency.

Update exchange rates
Rates of some currencies cannot be updated over the Internet (for example, virtual). Uncheck the box
not to get error messages during updates.

Alignment
Alignment of a symbol, left of right. Some currencies may have a symbol on the left ($100), others have it
on the right (100€).

Format
Number of digits after comma. Some currencies do not have "cents" (Japanese yen), some are divided to
1000 "cents". This option affects only how amounts are displayed in the program. Internal calculations are

always performed with maximum accuracy - more than 10 digits after the comma.
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Exchange rates
You can edit exchange rate manually or download from the Internet.
 

First currency
Select the first currency.

Second currency
Select the second currency.

Exchange rate
Enter the exchange rate.

Download rates
Download rates from the Internet.

 

http://www.alzex.com


Alzex Personal Finance software user guide.

Copyright (c) Alexandr Shirokov. All rights reserved. www.alzex.com

Accounts
Accounts represent the main method of separating transactions (expenses and income) in budget software.
Usually, the account in the budget program represents your real account. Accounts can be grouped. Each
account must have a currency assigned.
 

Add
Create a new account or group.

Edit
Change account settings.

Delete
Delete an account. All transactions associated with this account are deleted too. So, make sure you do
not lose important data!

Order
Select an account and click the Up / Down buttons to move it up or down.

Initial balance
Initial balance of an account.
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Account

Name
Account name.

Hide account
You can hide an account that you do not use regularly. You can enable viewing of hidden accounts on
the settings panel.

Comment
Account description.

Icon
The program allows you to choose from a variety of icons to make it easier to distinguish accounts.

Group
Select an account group.

Currency
Each account needs to be assigned its own currency.

New group
Create a new group.

Currencies
Open the list of currencies.
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Initial balance
Initial balance of an account, money on the account at the moment of its creation.

Access rights
Manage access rights.
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Account group
Accounts can be grouped. Group settings are the same as those of account settings, except the initial balance.
 

Name
Group name.

Comment
Description of a group

Icon
Group icon

Currency
Similar to an account, you need to assign a currency to a group. Balance is equal to the sum of balances
of accounts that belong to this group, taking into account the exchange rate if currencies are different.

List of currencies
Open the list of currencies.

Access rights
Manage access rights.
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Reconciliation
Reconciliation of accounts is a process of reconciling your current balance in the budget software and information
obtained from the bank statement to ensure that these amounts reconcile. Perhaps you have already created and
entered some transactions in the program, but they are not yet reflected in the bank statement. Or, perhaps, the
bank adjusted transactions in your account and you have not reflected these adjustments in the program.
 
To reconcile an account, you need to open the Reconciliation dialog (Tools > Reconciliation), select an account,
date and enter the amount specified in the bank statement, so that the budget program can compare it against its
own data. If the program says that the balances agree, click Reconcile.
 

Account
Select an account for reconciliation.

Date
Date of reconciliation.

Current balance
Enter the current balance on the account.

Calculated balance
Enter the balance in the program.
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Difference
Difference between the real balance and balance in the program. If the difference is equal to zero, you
need to adjust the balance.

Select all
Select all transactions.

Clear all
Unselect transactions.
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Categories
Alzex Personal Finance software is based on the idea of dividing income (and expenses) by categories. This
allows you to see areas of expenditure and amount of money spent without having to analyze reports. The
system of categories is designed in the form of a tree with unlimited nesting. Each category may have its own sub
categories, and sub categories may have their own sub categories. Also transactions can be separated by family
members and defined with special tags. As a result, you can easily evaluate the flow of money, starting from the
big picture and down to the smallest details.
 
The system of categories allows you to separate transactions by their type. It helps you to track home budget,
know exactly how much money is spent and what categories that money is spent on, pinpoint areas of excessive
expenditure and cut down unnecessary expenses. The same can be said about separating by family members,
payees and projects. Tags are like categories. However, a transaction may have only one category and unlimited
number of tags.
 
To move one category to another, simply drag it with the mouse. Drag the category to the empty place to move it
to the root.
 

Transactions
List of categories for transactions.

Events
List of categories for events. (this function is available in Pro version only)

Budget
List of categories for items of budget and savings.
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Loans
List of categories for debts and credits.

Family members
List of family members.

Payee
List of payees.

Projects
List of projects. (this function is available in Pro version only)

Tags
List of tags.

Add
Add a new category (family member, tag, etc.).

Add child
Add a child category to the selected category.

Edit
Edit a category.

Delete
Delete a category. All transactions of this category move to the parent category.

Sort

Sort categories. Move an item up or down, sort the entire tree in alphabetical order.
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Category

Name
Category name (family member, tag, etc.).

Icon
Click the button to select an icon for the category.

Comment
Category description.

Access rights
Manage access rights.
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Transactions
Transaction is the key concept in the budget software. A transaction is any movement of funds, such as expense,
income or transfer of money from account to account. A transaction must be associated with one of the accounts
(or two accounts in case of money transfer from one account to another). Transactions and splits. To see
transactions associated with a certain account, you need to select this account from the left list. You can sort
transactions by any field and change column width. By right-clicking the header, you can select columns to
display and their order. Also you can drag columns by headers to customize their order.

 

Accounts

• Show / hide account panel.
• Select an account from the drop-down

list.
• Select to display hidden accounts.

http://www.alzex.com


Alzex Personal Finance software user guide.

Copyright (c) Alexandr Shirokov. All rights reserved. www.alzex.com

View

• Divide transactions to income and expenses.
• Organize transfers to a separate group.
• Organize loan repayment transactions to a separate group.
• Show total.
• Show future transactions (scheduled and created for a future

date).
• Select columns in the list of transactions.

 

Group by

Group transactions by categories, family members, payee, projects, splits and description.

Settings panel
Viewing options.

Filters
Show / hide filter panel.

Actions
Show / hide actions panel.

Accounts
Show / hide account panel.

Header

Click the header to sort data in this column. Right-click the header to configure the look and order of
columns.
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Uncleared transactions

Uncleared transactions do not influence the balance. They are in grey and strike out.

Transactions

Transactions are grouped by categories.

Scheduled transactions

Scheduled transactions are in grey and have a scheduler icon in the Date column.

Total

Income minus expense for the selected period.
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Transaction
Transactions can be of three types: expense, income or transfer of money from one account to another. If you
transfer money between accounts with different currencies, you need to enter the exchange rate. The rate is
entered automatically from the corresponding directory, but you can change it for any transaction.
 
To create a new transaction, you need to enter minimum data: amount of the transaction, date and account.
Other settings are optional.
 

Type

Type of a transaction - income, expense or transfer.

History

This button helps you to enter recurring transactions without the need to type data to all fields of the
form. For this, select a transaction from the list and make edits if necessary. Other fields are completed
with data automatically.

Advanced settings

Open the tab with advanced settings.

http://www.alzex.com


Alzex Personal Finance software user guide.

Copyright (c) Alexandr Shirokov. All rights reserved. www.alzex.com

Account
Account that will be credited or debited money. If you transfer money, specify credit and debit accounts
and exchange rate (if account currencies are different).

Amount

Amount of the transaction in the account currency. Click the Plus (+) button to display additional fields:
price, quantity and discount (tax). You can enter data to any two fields from three (price, quantity and
amount), the latter is calculated automatically.

Tax is entered as a number (not percents). If the number is positive, this is a tax (total amount of the
transaction will increase by this number). If the number is negative, it is a discount (amount of the
transaction is reduced by this number).

Date
Date of transaction. By default this is the current day or date of the last entered transaction. The field is
inactive if the schedule is set.

Description
Description of a transaction. You can choose a description from the list of transactions that were entered
earlier and that are related to the selected category.

Status
Status of a transaction - cleared, uncleared, reconciled. Uncleared transactions do not influence balance.

Comment
Here you can type any text that describes a transaction.
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Categorization
This option allows you to specify the category, family member, add tags, etc. Read more...

Extra fields
Three extra fields for every transaction.

Files
Links to external files.

Schedule
Set the schedule for the transaction.

Currency

The currency of a transaction may differ from the currency of an account (for example, you withdraw
dollars from ATM and you have a euro account). In this case, select the currency of a transaction and
exchange rate to the currency of an account.

Access rights
Access restrictions.
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Split
A split is a group of transactions with common properties. It may contain transactions of all types - income,
expenses and transfers.
 
You can specify category, discount, family member or add tags to all transactions in the list.
 

Add
Add a new row.

Copy
Copy the selected row.

History

This button helps you to enter recurring transactions without the need to enter data to all fields of the
form. Simply select a transaction from the list and change values (quantity, amount) if necessary. Other
fields are filled with data automatically.

Delete
Delete the selected row.

Type of transaction
Click the button to select the type of transaction - income, expense and transfer.
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Transfer settings

• Withdraw from selected account
• Amount
• Exchange rate (if necessary)
• Amount
• Target account

Settings

• Debit or credit account for all transactions, date, status, description and
comment.

Extra fields
Extra fields of a transaction.

Files
Links to external files.
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Access rights
Managing access.
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Categorization
Transactions (and other records) can be organized to categories and family members, and you can add to them
unlimited number of tags. Categorization by payee and projects is available only for the commercial license.
 

Categorization

Select a category, family member, etc. Click the button to open the window for selecting a category. Here
you can also add a new category. Click the arrow to quickly select a category from the list.

Tags

List of transaction tags.

Add or delete a tag
Click Plus (+) to select a tag from the list.
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The "Select tags..." option opens the window where you can add new tags or select several tags.
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Extra fields
This budget software provides three extra fields for each transaction (two textual and one checkbox). They can
be used to enter necessary information, such as receipt number, confirmation, transaction number in the bank
statement, etc. You can rename extra fields by clicking the "..." button or via Tools of the main menu.

 

Customize
Click this button to rename extra fields.
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Links to external files
Transactions, splits or events can be linked to external files. These files are not stored in the database, only links.
 

Files
Double-click a file to open it in the external program.

Add
Add a link to a file.

Delete
Delete a link.

Open folder
Show a file in Windows Explorer.
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Calendar
The calendar displays all payments or events for any past or future day, as well as the balance at the end of the
day. Each cell of the financial calendar corresponds to one day. By default, the program displays information for
a month, but you can select any period of time you want. Each cell shows transactions or events for that day,
already existing or planned, as well as the total income or expense for the day and balance.
 

Accounts

Show / hide account panel.

View

• Show transactions or events
• Show cash flow
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• Show the balance
• Select the minimum height of a

cell

Group by

Group transactions or events by categories, family members, payee or projects.

Settings panel
Viewing options.

Filters
Show / hide filter panel.

Cash flow

Amount of income and expenses for the day.

Balance

Account balance at the end of the day.
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Scheduler
The scheduler creates regular transactions (for example, monthly bills for the apartment, telephone, Internet,
etc.). These transactions are created automatically at a predefined time, so you do not have to do anything
manually. You need to enter all transaction data and set the schedule only once.
 
In the list of scheduled transactions under the "Date" column, you can check the status of the schedule (active or
not) and see the date of the nearest event. The context menu of the scheduled transaction has an option called
"Accept" that allows you to create a transaction instantly. So, it is easy to create similar transactions that you
cannot create a schedule for (those that occur occasionally). If the schedule is available, a transaction is created
after clicking the Accept button. In this case, the schedule moves to the date of the next event. Configuring a
transaction schedule.
 

View
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• Switch between the lists of planned transactions and
events.

• Separate transaction to income and expenses.
• Organize transfers to a separate group.
• Organize loan repayment transactions to a separate

group.

Group by

Group planned transactions or events by categories, family members, payees or projects.

Filters
Show / hide filter panel.

Actions
Show / hide actions panel.

Date and status

Date of the next event and status of the schedule (active or not).

Transfer amount

Note that the amount of transfer is equal to zero because you selected a group of accounts and transfer
is made within this group. Debit and credit are shown in gray.
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Schedule
Scheduled transactions are created automatically. Select the schedule (weekly, monthly, regular) to select the
days and specify the start and end dates (if needed).

 

Schedule
Weekly, monthly, recurring (every few days) and without a schedule. Transactions without a schedule
can be created manually when needed.

Settings

Specify when you want an event to run.
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Select months and day for an event to run (1-31 or last day of the month).
 

Every few days.

Start date
Specify the start date for the schedule.

End date
Specify the end date (if necessary).
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Budget
(this function is available in Pro version only)

The Personal budget section makes it easy and convenient for you to monitor progress in achieving your financial
goals. Controlling home finances is fairly simple. All you need is to spend less money than you get. This is
generally true for all. If you do not follow this rule, you will be tangled up in debt.
 
This budget software offers a fairly simple, yet effective tool for controlling expenses and managing the personal
budget. Once the budget is set, the program automatically calculates your income and expenses and compares
them with the amount you plan to spend during a week, month or year. The program displays the personal
budget graphically and numerically, how much you exceeded the limit and how much you can spend without
going beyond reasonable limits. Creating and editing budget entries.
 

View

Select columns and their order.

Group by
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Group budget items by categories, family members, payee or projects.

Filters
Show / hide filter panel.

Actions
Show / hide actions panel.

Tracking savings

Controlling savings, how much is planned to save, how much is actually saved, balance and progress.

Tracking budget

Budget, how much can be spent, how much is spent, balance and progress.

Detailed information about the selected budget item
Money spent in previous months, money spent on average during all periods. Forecast for next months
(based on planned transactions). View transactions that fall into this personal budget item. You can
select the depth of history and forecast from the drop-down list.
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Edit budget entry
(this function is available in Pro version only)

Type
You can track both budget (expenses) and savings (income minus expenses).

Advanced settings
Show the advanced settings panel.

Amount
Amount you want to save or amount that you cannot exceed.

Currency
You need to select the currency.

Interval
Budget tracking interval - day, week, month, quarter or year. You can also select a date range (for
example, if you want to save a specified amount for the vacation):

Name
Short description of a budget item.
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Comments
Here you can enter any text describing this budget entry.

Categorization
This allows you to select a category, family member, add tags, etc. Read more...

Include filters

You can select to include transfers, payments of debts, uncleared transactions and transactions with
a mark in the extra field #2 (see Extra fields). The filter includes transactions that fall into a specific
category or have a specified tag. The program takes into account transactions satisfying all conditions.

Exclude filters

You can exclude uncleared transactions and those with a mark in the extra field 2. If you select these
conditions, they are automatically removed from include filters. If, for example, the extra field is selected
neither in excluding filters, nor in including ones, the value of this transaction field is ignored (the
program includes transactions with and without the mark).
 
The filter excludes transactions that fall into a specific category or have specified tags. Transactions that
satisfy at least one of the conditions will be excluded.

History
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There are two ways to track budget. Each period is independent and amount of expenses at the
beginning of the period is always the same - previous values are ignored. When the "Include previous
values" option is enabled, any over expenditure or money saving for the previous period is included
in the next period and amount at the beginning of the period can be reduced or increased. Select the
number of periods to be included.

Access rights
Managing access.
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Loans
This section is for tracking loans. You can borrow and lend money and it can be reflected in the program. To pay
debts, you can use any account and currency (you need to specify the exchange rate). For this, click + button
at the top of the repayments list to create a transaction. It is expense if you pay the debt. If you get your money
back, it is income. Debts can be paid in full or in part. Select the payment amount, if the currency of a transaction
does not match the currency of a debt, enter the exchange rate. Creating and editing loans.

 

View

• Separate debts and
credits.

• Show total.
• Select columns and their

order.

Group by
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Group debts by categories, family members, payee or projects.

Filters
Show / hide filter panel.

Actions
Show / hide actions panel.

Debts

List of debts, total sum, balance and progress.

List of taken credits

List of your credits, total sum, balance and progress.

Total

Total amount of all debts, payments and balances.

Payments on selected debt

List of transactions - payments on debt. Progress and balance. Right-click on transaction and click copy to
quickly create a new repayment transaction.
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Edit loans

Borrow or Lend
Borrow or lend money.

Amount
Amount of debt.

Currency
You need to select the currency if the amount of debt is not credited or debited from the account.

Account
Amount of debt can be credited or debited from the account. If you do not get cash when you take a
loan, select "none" and select the currency of the debt.

Date
Date of credit.

Date of payment
Date of debt repayment

Name
Short description of debt.

Comment
Here you can enter any text describing the debt.
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Advanced settings
Open the advanced settings panel.

Categorization
Allows you to specify a category, family member, add tags, etc. Read more...

Interest rate

Interest rate. Enter the interest rate, crediting period in months, type of payment and the budget software
will calculate the total repayment amount. It may slightly differ from the real one because different banks
can calculate the amount of repayment in different ways.

Access rights
Managing access.
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Reports
The budget software offers various charts and reports. Information is presented in numerical and graphical form.
 

View

• Overview - summary for the selected period divided by categories, family members, etc. Pie chart or
bar chart.

• Trend. Charts: line, bar or area chart.
• Report on income.
• Report on expenses.
• Include transfers into report.
• Include loans into report.
• Select columns for the list of transactions below.
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Group by

Group data by income and expense, categories, family members, payee and projects.

Chart type
Chart type. Pie chart or bar chart for summary and line, bar or area chart for trends.

Period

• Day - trend divided by days for the selected period of time. Minimum period is two
days.

• Week - trend divided by weeks. Minimum period for creating a chart is two weeks.
• Month - trend divided by months. Minimum period for creating a chart is two

months.
• Quarter - trend divided by quarters. Minimum period is six months.
• Year - minimum period is two years.

Settings panel
Viewing options.

Filters
Show / hide filter panel.

Legend
Double-click the name of any category to view a report about its subcategories. You can select only
those items that you want to see on the chart.

• Level up.
• Select all.
• Clear all.
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Events and tasks
(this function is available in Pro version only)

Here you can see tasks whose execution needs to be monitored and events that you do not want to forget. Tasks
differ from events in that they have a status (in progress, failed, completed) and priority. Events just happens.
Creating and editing events.
 

View

• Separate events and tasks.
• Select columns and their

order.

Group by

Group events and tasks by categories, family members, payee or projects.

Settings panel
Viewing options.

Filters
Show / hide filter panel.

Actions
Show / hide actions panel.
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Tasks

List of tasks and their completion in percents for each group.

Events

List of events.

http://www.alzex.com


Alzex Personal Finance software user guide.

Copyright (c) Alexandr Shirokov. All rights reserved. www.alzex.com

Edit events and tasks
(this function is available in Pro version only)

Type
Event or task. A task has a priority and status (failed, in progress, completed).

Title
Short description of the event

Date
Date of event.

Status
Task status - failed, in progress, completed.

Priority
Task priority - from the lowest to the highest.

Comment
Here you can enter any text describing the event.

Advanced settings
Open the advanced settings panel.

Categorization
Select a category, family member, add tags, etc. Read more...
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Files
Links to external files.

Schedule
Set the schedule for an event.

Access rights
Managing access.
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Users and access restrictions
(this function is available in Pro version only)

There is always at least one user in the system - Administrator. If necessary, you can add more users. This lets
you see who created a record, protect your own records from changes and hide from other users (see access
rights). It makes sense to set a password for each user.
 
The administrator account has a special status. Only the administrator can create and delete other users. Also
the administrator can see all records (including hidden ones), edit records protected from changes and change
the owner of a record.
 
See also: Team work with one database file
 

Users
List of users.

Add
Add a new user.

Edit
Edit the user profile.

Delete
Delete the user. The administrator account cannot be deleted!
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User
(this function is available in Pro version only)

Icon
Click the button to select the icon for the user.

Name
Name of the user.

Comment
Description of the user.

Password
Password. Each user can set a password (File > Set Password).

Password hint
Enter a hint in case you forget the password.
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Access restrictions
(this function is available in Pro version only)

It is possible to hide almost every record from other users or protect it from changes. Only the owner of this
record (the one who created it) and the administrator can set access rights. The administrator can edit any
record, see hidden records and change the owner.
 
When you open a transaction for editing, you can find the button with the lock in the lower left corner of the
window. Click this button to open the menu where you can set access rights. Also you can assign access rights to
multiple records at once using batch editing.
 

Enable protection

• Read only
• Hidden
• Owner (available only for the

administrator)
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Data export
Alzex Personal Finance software allows you to export data to QIF (Quicken Interexchange format), CSV (Comma
separated values) and text with delimiters (tabs, commas, etc.).
 
QIF files are a universally recognized standard for information exchange between personal budget software.
However the file format is strictly limited and not all information can be exported to this format. If you need to
export all fields of a transaction, try export to CSV file.
 
CSV files can be opened in Excel and imported by most home budget software. Though there are no clear rules
and specifications for such files, this format allows you to export maximum amount of data, whereas, for example,
QIF is strictly limited and only some data from Alzex Personal Finance budget software can be exported to this
format.
 
On the main menu, click Tools > Export. This opens the window for selecting a file. Select the file type that you
want to use for data export (QIF, CSV or TXT) from the drop-down list at the bottom of the window. Enter the file
name and click Save. This opens the export settings window. Select all necessary settings and click OK.
 

 

Export
Click the button to export data.
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Export to QIF
QIF files are a universally recognized standard for information exchange between personal budget software.
However this file format is strictly limited and not all data can be exported to this format. If you need to export all
fields of a transaction, try export to CSV file

 

Interval
Time interval for export. Transactions that do not fall into this time period will not be exported.

Account
The program exports transactions related to this account.

Date format
Default system format is usually fine. Sometimes the program recognizes only one date format. In this
case select from the list or enter the necessary format.

Check number
This term is not used in our budget software. You can specify one of the extra fields as a check number.

Encoding
Encoding - ANSI or a variant of Unicode. QIF format uses ANSI. Some letters in ANSI files may be
unreadable in a system where English is the default language, but most programs fail to recognize QIF
files encoded in Unicode.

Export categories
QIF file may contain information not only about transactions, but also about categories. Tick the
checkbox if you want to include categories into the file.

Export transactions
You can export only the list of categories without transactions.
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Export to Text or CSV
This file type can be imported by most home budget software and spreadsheet applications like Excel. Although
there are no clear rules and specifications for such files, this format allows you to export maximum amount of
data, whereas, for example, QIF format is strictly limited and only some data from our budget software can be
exported to this format.
 

Interval
Time interval for export. Transactions that do not fall to this time interval will not be exported.

Account
You can include transactions from a particular account or all accounts.

Date format
Default system format is usually fine. Sometimes a program recognizes only one date format. In this
case select from the list or enter the necessary format.

Decimal separator
Typically, it is a comma, character that separates the integer part from the decimal part. Select from the list
or enter any character.

Delimiter
Delimiter is a symbol that separates columns, usually a tab character.

Encoding
Encoding - ANSI or a variant of Unicode. Unicode is preferable because some letters in ANSI files may
be unreadable in the systems where English is the default language. However, Excel, for example,
recognizes CSV files correctly only if they are encoded in ANSI.

Selected fields
Select fields of transactions and their order for export.
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Data import
There are two main ways to load data to the home budget software. You can enter each transaction manually
or download data from online banking and import it to the program. You can import data in QIF (Quicken
Interchange Format), OFX (Open Financial Exchange), CSV (comma separated values) or a delimited text file
(tab, comma, or other delimiter). These are the most common formats for data exchange between personal
budget software.
 
On the main menu, select Tools > Import. This opens the window for selecting a file. Select the file type you
want to import (QIF, OFX, CSV or TXT) from the drop-down list at the bottom of the window. Find and select the
necessary file and click to open. This opens the import window. Select all necessary settings and click OK.
 

• Import QIF file
• Import OFX file
• Import text or CSV file

 
This opens the preview window of imported transactions. Here you can select transactions that you want to
import. If everything is correct, click OK to complete the import. If there are errors (wrong dates, numbers, or
gibberish instead of text), click Cancel and adjust the import settings.
 

Select transactions
Put a tick against those transactions that you want to import. All other transactions will be skipped. By
default transactions that are already in the database, are not selected (if the Detect Duplicates option
was enabled).
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Select all
Select all transactions.

Clear all
Unselect all transactions.
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Import QIF

Account
Select an account that imported transactions will be associated with.

Date format
Select the date format from the list or enter the format that matches dates in the file.

Decimal separator
Decimal separator is a symbol separating the integer part from the decimal part. Choose from the list or
enter your own symbol.

Check number
This term is not used in our budget software. You can select one of extra fields that will be used for the
check number.

Payee
The Payee field usually contains information about a payee but sometimes it may contain other data (for
example, description of a transaction). Choose one of the options from the list.

Encoding
Usually file encoding is recognized automatically without any problems. However if the program cannot
recognize encoding and you see gibberish instead of meaningful text, you can select encoding from the
list.

Duplicates
This option allows you to detect duplicate transactions and avoid their duplication during import.
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Opening balance
In a QIF file, the first transaction from the list contains information about the opening balance of the
account. Usually it is recommended to ignore this transaction.
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Import OFX

Account
Select an account that imported transactions will be associated with.

Decimal separator
Decimal separator is a symbol separating the integer part from the decimal part. Select the symbol from
the list or enter your own symbol.

Transaction ID
Transaction ID is not used in our home budget software. You can select an extra field for placing ID.

Check number
Check number is not used in our budget software. You can select an extra field for placing the check
number.

Encoding
File encoding is usually recognized automatically without any problems. If the program cannot recognize
file encoding and you see gibberish instead of meaningful text, you can select encoding from the list.
UTF-8 is a standard for OFX.

Duplicates
This option allows you to detect duplicate transactions and prevent their duplication during import.
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Import of Text and CSV

Profile
If you need to import files of different formats, you can save import settings as a profile. For this,
configure all necessary settings, enter the profile name and click Save. The next time you import a file,
simply select the profile from the list and all the settings will be set to their previous values.

Account
Select an account that imported transactions will be associated with. This account will be used if the
"Account", "Debit account" or "Credit account" columns are not specified, or the account name does not
match any of the accounts in the system.

Encoding
File encoding is usually recognized automatically without any problems. If the budget software cannot
recognize encoding and you see gibberish instead of meaningful text, you can select encoding from the
list manually.

Delimiter
You can select a data delimiter from the list or enter your own. Changes are instantly reflected in the
table.

Date format
Select the format from the list or enter the one that exactly matches the date format in the file.
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Decimal separator
It is usually a dot or comma separating the integer part from the decimal part. Choose from the list or
enter a symbol corresponding to the amounts in the imported file.

First row
Most files contain column headers, you do not want to import. In this case, import should start from the
second row.

Duplicates
This option allows you to avoid duplication of transactions during import.

Header

You need to specify the type of each column before starting import (by clicking the header). At least
you need to specify the amount and date of a transaction. If you do not want to import data from some
columns, leave their type as <none>.

Amount

The type of a transaction depends on the selected columns. Amount is determined automatically using
the value in this column. If the amount is negative, the transaction is determined as expense. If the
amount is positive, the transaction is determined as income. Debit - all transactions are recorded as
expense. Credit - all transactions are recorded as income. Columns can be combined. For example, if a
file has two columns with a debit amount and credit amount and all numbers are positive, specify debit
and credit columns. If a debit column has a negative amount, and a credit column has a positive amount,
specify the Amount type for both columns.

Categories

Categories will be created automatically. A colon is used for separating categories and subcategories (for
example, Products: Dairy: Cheese)

Tags
A transaction may have several tags. In this case, the name of each tag must start with a new line.

Account

In addition to income and expenses, you can also import transfers from one account to another. For this,
you need to go to the Account column and specify both accounts using a colon: Debit account:Credit
account. Both accounts must be present in the system.
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Application settings
Here you can see global settings of Alzex Personal Finance software. To open the dialog, click Tools >
Application settings. Also this window opens on the first run of the program.
 

Language
Our home budget software was translated to many languages and you can choose any of them. Since
the program is translated by users on their own, you may see incomplete or incorrect translation to
some languages. We would appreciate if you could send updated or corrected translation. Translated
files are plain text files, stored in the program folder, for example: C:\Program Files\Alzex Finance\Lang\

Date format
The program uses the default date format set in the system. Also you can specify any other format you
want.
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Number format
Decimal separator - settings that define the display of amounts in the program. In USA generally use
1,000.00. You can choose any format you like.

First day of week
The week may start on different days in different countries. In the United States it is Sunday.

Toolbar captions
You can disable toolbar captions to save space.

Overview tab
The program remembers the last tab that you worked with and opens it when you run the program again.
If you want the program to open the Overview tab at all times, you need to check this box.

Currency rates
Update currency exchange rates on each app startup.

Synchronization
Automatic synchronization

Backup
It is recommended to back up your budget database at least once a week. The database is a small file
and copies will not take much space. By default backup copies are stored in My Documents\Alzex
Finance\Backup\, but you can choose another location.
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Setting Extra Fields
Alzex Personal Finance software provides three additional fields for each transaction (two textual fields and
one checkbox). You can use them to enter any necessary information, such as receipt number, number of a
transaction in your bank statement and more. Enter names for extra fields:
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Purchase and License
You can download and use our home budget software in free trial mode for 30 days. If you want to use the
program beyond the trial, you must buy the license. Once payment is received, your activation key will be sent to
your email address. Latest information about prices and licenses is available at: alzex.com.
 

Terms of Use
The product can be used for unlimited time after purchase. The license entitles the user to move the program
onto another computer that belongs him. Software activation over the internet is required (it is possible to activate
the program on the computer which is not connected to the internet, see manual activation). Free updates for a
year, paid upgrades (second and subsequent years) with a 40% discount. Free technical support for the life of the
product.
 

Types of Licenses

• Personal -  license for one user. Use of the license for commercial purposes is forbidden. Some additional
features of the program are not available for this license.

• Commercial - license for one user. All additional features are available: user accounts and access rights,
events and tasks, payee and projects.
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Program activation
To activate the program, click Help > Buy now... This open the window where you need to click the Enter Key
button. The easiest way to enter the key without errors is to copy and paste it (select the key and copy it to
clipboard by clicking Ctrl+C). Then paste it into the Key Activation field (click Ctrl+V). Click the Activate button
and restart the program. If the key is valid, the program unlocks all trial limitations.
 

Activation key
Enter or copy and paste your key.

Manual activation
If you fail to activate the software as described above, try to disable the firewall (you can enable it again
after activation) or try manual activation.
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Manual activation
If your computer is not connected to the Internet or automatic activation fails for some reasons, click the Manual
Activation button. This opens the windows with instructions as shown in the picture below. Follow the instructions
to activate the program. If you have difficulties or questions, contact our support team.
 

Activation request
Copy the request and paste it into the activation form on the website.

Instructions
Follow the instructions. Steps 2-4 can be performed on any computer connected to the internet.

Activation code
Enter the response of the server here, and then click OK.
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License agreement
Alzex Personal Finance software Copyright (C) Alexandr Shirokov
 
Alzex Personal Finance is not a freeware budget software. You can try it for free for 30 days. If you wish to
continue to use it, you have to register it.
Once registered, you get:
- License key. The license key removes all limitations of the evaluation version.
- Free technical support.
- Free updates for 12 month period.
 
Using an unregistered copy of Alzex Personal Finance software after the 30 days trial period is a violation of
the author's rights.
 
Alzex Personal Finance software IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED
OR IMPLIED. YOU USE AT YOUR OWN RISK. THE AUTHOR WILL NOT BE LIABLE FOR DATA LOSS,
DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS
SOFTWARE.
 
You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble, otherwise reverse
engineer, or transfer the licensed program, or any subset of the licensed program, except as provided for in this
agreement. Any such unauthorized use shall result in immediate and automatic termination of this license and
may result in criminal and/or civil prosecution.
 
Freeware sites and freeware/shareware catalog owners are granted permission to include this software on their
web sites and coverage CDs without written permission of the developer.
 
Installing and using Alzex Personal Finance software signifies acceptance of these terms and conditions of the
license. If you do not agree with the terms of this license you must remove Alzex Personal Finance software
files from your storage devices and cease to use the product.
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System requirements
• Windows Vista/7/8/10 (32/64bit)
• 40Mb of free disk space
• USB drive for Portable version
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Technical support
Technical support is provided by email. You can contact us at support@alzex.com. Registered users should
specify their activation key in the message.
 

Feedback
If you have comments or suggestions about our budget software, please contact us at community.alzex.com.
Your opinion and ideas are very important to us and help us improve the program. Many changes and features
were introduced by the users. So, if you have an opinion or idea about our home budget software, drop us a line.
 

http://www.alzex.com
mailto:support@alzex.com
http://community.alzex.com/
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